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Thank You for Selecting the Afinia DLF-1100 Digital Label Finisher 
At Afinia Label, we are committed to serving you, our customer. Our goal is to provide you with 

competitive, quality products to meet your needs. Customer input is of great value to Afinia Label; 

therefore, we encourage any comments or suggestions. 

The instructions contained in this manual are intended to ensure the safe installation, operation, and 

maintenance of your machine. Please read this manual carefully before performing any activity on 

the equipment. Please note information contained in this manual does not modify or alter, in any 

way, the standard terms and conditions of your Afinia Label purchase contract. 

This manual should be readily accessible to operating and maintenance personnel at all times. 

Proper use of this manual, in addition to other Original Equipment Manufacturer’s manuals and your 

in-house manuals, will assure safe, reliable and cost-effective performance of Afinia Label 

machinery. 

If you are in need of service, please contact our Technical Support staff as instructed on the following 

pages. In order to expedite your request please include the serial number of your machine. Each 

Afinia Label machine has a label identifying its serial number. 

General Information 
Afinia Label Operating Manuals and Addenda provide a general understanding of the operation of 

the contracted system, its major components, and the functional elements of those components. 

The Manuals and Addenda contain Safety, Description, Installation, Operation, and Maintenance 

information. We strongly recommend thoroughly reading and understanding the information in this 

manual before operating this equipment. If additional information is required, or clarification 

needed, feel free to contact Afinia Label. 

The Manuals and Addenda may not be copied or reproduced, in whole or part, without written 

consent of Afinia Label. 

Receiving and Inspecting the Equipment 
Inspect the Afinia Label equipment immediately upon arrival at the installation site as follows: 

1. Note any visual in-transit damage to the packing crate or the equipment on the 

carrier’s delivery slip. 

2. Report any concealed in-transit damage to the delivery carrier and to Afinia Label as 

soon as it is discovered.  When possible, take pictures for claim purposes. 

3. Cross-reference amounts received to amounts shipped as indicated on the packing 

lists forwarded with the machinery. Report shortages and/or defective material 

immediately to Afinia Label customer service office. 
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Disclaimer of Warranties and Limitation of Liabilities 
The Afinia Label DLF-1100 is warranted free of defects in both materials and workmanship. Should 

any part of this equipment be defective, it will be repaired or replaced, at the option of the 

manufacturer, at no charge for parts or factory labor for a period of one (1) year from the date of 

installation. All warranty services are performed by Afinia Label Service.   Replacement parts not 

installed by Afinia Label will be billed to the customer at regular prices and credit will be issued when 

the defective parts are returned. The customer is responsible for freight on warranty parts and 

repairs. 

This warranty is void if: 

The equipment has been damaged by negligence, accident or mishandling, or has not been 

operated in accordance with the procedures described in the operating instructions; 

or: 

The equipment has been altered or repaired by other than an approved service station or 

factory service center, or adaptations or accessories have been attached to the equipment that 

shall have adversely affected the performance, safety, or reliability of the equipment. 

NO OTHER WARRANTY, EXPRESSED OR IMPLIED, APPLIES to the equipment. Afinia Label does not 

assume any responsibility for consequential damages occasioned by the equipment, or 

inconvenience or interruption in operation. 

In case of unsatisfactory operation, Afinia Label or its Dealer should be notified immediately. 

Technical Support 
For Technical support, please use the contact information below based on your location. 

North, Central, & South America Europe, Africa, Asia, Australia 

Afinia Label, US 

Email:  support@afinia.com 

Phone: 952-279-2643 

Hours:  Monday-Friday 

8:00-5:00PM Central Time 

Afinia Europe 

Email:    tech@afinia.co.uk 

Phone:  +44 (0) 845 250 7949 
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Specifications 

System Data: 
Contour Cutting Full HPGL vector cutting 

compatible with 

SMARTMark opto-electrical 

line sensor Average Speed 10 feet/min | 3.04 meters/min 

Web Width 4 to 8.5 inches (100 - 215 
mm) Max Frame Length 14 inches | 35.5 cm 

Max Input Roll Diameter 8 inches | 20 cm 

Max Output Roll Diameter 8 inches | 20 cm 

Recommended Roll Length 500 feet | 153 meters 

Make Ready Waste 4 feet | 1.2 meters 

Cutting Technology Pivoting carbide tip 

- 30, 45 & 60 

degree User Interface Touch panel display 

Test Cut Function Yes 

Warranty Limited Liability 1 year 

 

Network Connections: 
Ethernet � 100BASE-TX 

� 10BASE-T 

USB High Speed 2.0 

 

Power Requirements: 
DLF-1100 500 watts voltage input ranges 

100-240 VAC / 47-63 Hz 

 

Dimensions and Weight: 
Depth 21 inches | 53 cm 

Width 31 inches | 79 cm 

Height 22 inches | 56 cm 

Weight 185 Lbs. | 85 Kilograms 
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Items Shipped Unassembled from Machine 
An accessory kit is shipped with the equipment in the crate. These items are required for operating 

the DLF-1100 finisher. The tools included in this kit are specifically sized for the machine and should 

be stored nearby for easy access. The kit contains the following items: 

Accessory Kit: 

Component ID Description Qty 

30040018 Weed Bar O-Rings 12 

40239063 AC Power Cord, European Style 1 

DT-00-11-141 Web Centering Gauge 1 

DT-00-11-202 T-Handle Wrench 1.5 MM 1 

PL-00-03-533 CD, Software/Documentation 1 

DT-413 Cut Strip Removal Tool 1 

F-045 5A Normal Blow Fuse 2 

F-054 2.5 A Slow Blow Fuse 2 

H03-032 Pinch Wheel Spring (Medium Tension) 4 

H05-353 Ethernet Crossover Adapter 1 

H05-361 Black CAT 5E Ethernet Patch Cable, 14ft 1 

H05-360 USB Cable, 10ft Grey (A Male to B Male) 1 

H21-021 3.0 MM Hex Key Wrench (L Short Arm) 1 

H21-022 2.0 MM Hex Key Wrench (L Short Arm) 1 

H21-023 1.5 MM Hex Key Wrench (L Short Arm) 1 

H21-024 4.0 MM Hex Key Wrench (L Short Arm) 1 

H21-010 3/32 IN Hex Wrench (L Shaped) 1 

LS-179 7/64 IN Hex Wrench (Long) 1 

H20-007 45 Degree Knife Blade (Red Cap) 1 

H20-008 60 Degree Knife Blade (Green Cap) 1 

H20-017 30 Degree Knife Blade (Blue Cap) 1 

PL-00-02-865 Control Depth Knife Holder 1 

CN-016-10 Slitter Blade 10pk 1 

DT-149 Core Partition Flange 3 

 

  



Page 9  User’s Manual 

 

 

Introduction 
The DLF-1100 Digital Label Finisher is shipped assembled. However, it must be properly unpacked, 

installed, and setup to run prior to operating. This manual will guide you through this process. 

Safety 
For your own safety, read this instruction manual before operating the equipment. 

Knowledge of the machine’s components and specific hazards will minimize the possibility of 

accidents and injury. 

Wear proper clothing. Do not wear loose clothing, neckties, necklaces, or jewelry, which may be 

caught in moving parts. Shoulder length hair and longer should be pulled back, and secured at all 

times to prevent catching in equipment. 

Keep your work area clean and well-lit to prevent tripping or accidently placing arms, hands, and 

fingers in danger. 

An Emergency Stop push button is located on the front of the machine near the cutter. Do not use 

the E-stop to power off equipment unless there is an emergency. 
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Site Preparation 
The following are guidelines for preparing the customer site for installation of the Afinia Label 

equipment. 

Location: 
1. Provide a sturdy level area for equipment weighing 220+ lbs. 

2. Provide adequate clearance around the machine to allow easy access for inspection 

and maintenance. 

3. Ensure there is an appropriate power source and Ethernet connection nearby. 

Power Requirements: 
Use of a HIGH QUALITY surge protector or uninterruptible power supply is REQUIRED by Afinia Label. 

Failure to do so could affect your warranty coverage if a problem arises due to improper power 

connection! 

Risk of Electric Shock - The power cord is a three-conductor cable that uses a safety     

(earth) ground connection. The power cord must be plugged into an outlet that has an 

earth ground contact. NEVER plug the power cord into a two-prong outlet by using a 3=2 

cord adapter. 

Risk of Electrical Fire - NEVER allow roll or sheet goods to rub on the power cord as the     

material may damage the cord causing an electrical fire hazard! 

Power Configuration: 
Afinia Label products are factory preset for the power requirements of the destination country. The 

machine configuration is indicated on the power input module as either 115V or 230V. 

Changing the Fuse Configuration: 
1. Disconnect the AC power cord from the fuse block on the power input end panel. 

2. Open the fuse block cover with a small flat screwdriver and pull out the fuse 

block. 

(Continued on next page) 

  

Fuse Block 

Power Button (Ref) 

Fuse Block Cover 

Figure 1: Fuse Block Access 
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Voltage shown “right -

side-up” will show when 

the fuse block cover is 

replaced 

 

 

 

 

 

Use 5-amp fuse for 115v system. 

One fuse and one shorting clip 

 

For 230v system, remove shorting 

clip and use two 2.5 amp fuses, one 

on either side 

Changing the Fuse Configuration (continued): 
3. Reverse the position of the fuse block so that the desired voltage will appear in the 

fuse block cover. 

4. Close the fuse block cover and verify that the desired voltage is showing. 

 

 

Risk of Electrical Fire - Do not change the fuse location in the fuse block. Do not put a 

5-amp fuse in place of a 2.5-amp fuse or put a 2.5-amp fuse in place of a 5-amp fuse. 

  

Figure 2: Fuse Block 
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Hex 

Bolt 

Mounting 

hole for foot 

Installation of DLF-1100 Digital Label Finisher 

Setup Finisher 
The DLF-1100 Finisher is a tabletop label finishing device. Once removed from its crate, place the 

unit on the included stand or on a table that can support 220+ Lbs (100 kg). 

To unpack the DLF-1100, you will need: 

• Scissors or knife 

• ½” wrench 

• Level 

• Minimum of 3 people for lifting 

Unboxing 
1. Cut the straps holding the outer box to the pallet 

2. Remove the outer box from the pallet 

a. The shrink wrap on the box does not need to be 

removed 

3. Cut the three straps securing the stand box to the DLF-1100 

4. Remove the plastic bag and foam padding 

5. Remove the accessory box from under the output mandrel 

a. You will need some of the tools in the accessory box 

to complete the setup 

6. Using the ½” wrench to hold the bolt heads (underneath the 

pallet), remove the four wing nuts holding the U-bars to the pallet  

a. Please save the pallet, bolts, wing nuts, and washers 

Setup without Stand 
1. Carefully lift the DLF-1100 onto the prepared surface 

Lift with a minimum of three people, please! 

2. Position the DLF-1100 so that you can access the front 

two hex bolts holding the U-bars to the base of the DLF-

1100 

a. If overhanging the edge of a table, only 

overhang enough to access the hex bolts 

3. Remove the two front hex bolts using the 4mm hex 

wrench included in the accessory box 

4. Screw two of the feet into the front outer mounting 

holes 

a. The feet are shipped in the Stand box 

b. For ease in removing the U-bars, make sure the height of the feet are higher than the 

height of the U-bars 
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Hex 

Bolt 

Mounting 

hole for foot 

5. Lift the front of the DLF-1100 and slide back so the rear two hex bolts are accessible 

6. Remove the rear two hex bolts using the 4mm hex wrench 

7. Screw the remaining two of the feet into the rear outer mounting holes 

8. Position the DLF-1100 so all four feet are on the surface and remove the U-bars 

a. If the feet are high enough, the U-bars will slide out easily 

b. Please save the U-bars! 

9. Carefully lower the feet and level the DLF-1100 

a. Keep the feet far enough out for fingers to safely lift the DLF-1100 

Setup with Stand  
1. Assemble the Stand 

a. The shelf of the stand will be near the top when the stand is assembled 

2. Carefully lift the DLF-1100 onto a stable, raised surface 

Lift with a minimum of three people, please!   

a. Do not place it on the stand yet – the U-bars will 

damage it 

3. Position the DLF-1100 so that you can access the front 

two hex bolts holding the U-bars to the base of the DLF-

1100 

a. If overhanging the edge of a table, only overhang 

enough to access the hex bolts 

4. Remove the two front hex bolts using the 4mm hex 

wrench included in the accessory box 

5. Position the DLF-1100 so the rear two hex bolts are 

accessible 

6. Remove the rear two hex bolts using the 4mm hex wrench 

7. Position the DLF-1100 onto the stand, aligning the holes 

in the top of the stand with the mounting holes for the 

feet 

Lift with a minimum of three people, please! 

a. Please save the U-bars! 

8. Thread the feet through the holes in the stand and screw 

the feet into the DLF-1100 to secure the cutter to the 

stand 

9. Tighten all four feet as much as possible to ensure the 

DLF-1100 is securely on the stand 

10. Verify the DLF-1100 is level 
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Connection to PC 
Do not connect the DLF-1100 finisher to the computer until told to do so by the installation cd. 

Afinia Label Installation Disc 
The finisher utilizes either USB interface or Ethernet connection to the computer. 

The DLF-1100 comes with an installation CD that will walk you through connecting your equipment 

to your computer and installing software. 

The Setup CD contains: 
1. An installation program that walks you through connecting your DLF-1100 finisher to your 

computer. 

2. The Remote Panel Utility program for managing finisher settings. 

3. A current revision of firmware. “Firmware” is software that controls the machine 

functions. The firmware on this disk is provided for backup purposes and should not be 

installed on new machines. 

4. The DirectCut printer driver.  This driver been tested with AllenCAD, CorelDRAW (versions 

10-x8), Adobe Illustrator (versions 10-CC), Flexisign, and PowerCAD. It should also work 

with any program that sends vectors rather than bitmaps to the driver. The DirectCut 

printer driver allows cutting directly from windows graphics programs without requiring 

additional software purchases. 

Note: DirectCut requires ownership of Afinia Label Equipment to use. Requires: 

Windows10, Windows 8, Windows Vista, or Windows XP. Updated versions of the 

DirectCut printer driver are available on the tech support page at the Afinia Label web site 

at http://www.afinialabel.com/. 

5. During installation a test cut is performed to verify communication with the finisher. (no 

blade or material necessary) 

6. User’s Manual and sample jobs. 

7. A complete copy of the technical support section of the Afinia Label website at the time 

the machine was shipped. To access this offline copy of the web site answer no to 

question as to whether you want software installed on this computer. 
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Setting up your label job 
Files are created to add registration marks and cutting paths to label artwork. Once this is done, a 

“Cut” file is created using Allen DirectCut to send the information to the DLF-1100 Digital Label 

Finisher when the media is processed through it. 

Explanation of SmartMark 
The SmartMark™ for Afinia Label cutters is an optical registration system that ensures accurate 

cutting of pre-printed graphics. The SmartMark™ system can recognize up to three registration 

marks per frame, allowing adjustments for scale and skew discrepancies that may occur. 

The SmartMark™ sensor recognizes the change in contrast from the background of the media to the 

printed mark. The sensor sends a signal when the mark is scanned by the finisher to have the soft- 

ware calculate the position of the scanned mark and matches it with its corresponding origin point of 

the cut file. 

The registration mark(s) and die line(s) define the cutting area for each “Frame” of the printed label 

media. A registration mark and a die line must be created to use with the label artwork so that the 

DLF-1100 Finisher can cut the labels accurately. This is done by creating a new file that contains the 

artwork and registration mark on one layer and the die or cut line on a separate layer. 

Origin Registration Mark Placement and File Creation 
The steps below give the necessary placement of the mark when printing with the Afinia Label L801 

Printer.   

Follow the steps below to create the new label-cutting file with the registration mark set to “origin”. 

1. Open an existing working artwork file (pdf, eps, Ai, CorelDraw) 

2. Make the art board height equal to the label media width. This helps to visualize the actual 

size of the frame on the material. 

3. Name the current layer with your artwork “Artwork”. 

4. Click on the rectangle tool; its properties should be set to black fill with no stroke. 

5. Click in the lower right area of the art board and create a box that is ¼” square. 

6. Create a new layer and label it “Die Line”. 

7. Make the “Die Line” layer active. 

a. If you have it available from another file, cut (ctrl+X) and paste (ctrl+F) a die line to 

the die line layer. 

b. If there is no die line file, create the die line 

using the shape or pen tools. 

 

(continued)  
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The figure below shows how the elements of the label file looks with the die line and 

registration mark added. 

 

NOTE:  Die lines are created using “no fill” stroke lines. It does not matter what the stroke 

weight of the line is. 

8. Once the die line has been put in the file, center the label artwork and the cut lines (die line) 

within the center of the art board. 

9. Create a cross-hair to position the square as follows: 

a. Display the Ai rulers (View menu, then “show rulers”) 

b. Click on the vertical ruler and drag it to the furthest cut line on the right side of the 

image. Note its location and then move it right another ¼”. 

c. Click on the horizontal ruler and drag it to the lowest cut line on the bottom of the 

image.  

10. Click and drag the rectangle to align its left edge with the vertical guide and its bottom edge 

with the horizontal guide. 

The figure below shows the placement of the registration mark with the vertical and 

horizontal ruler guides. 
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11. Change back to the die line layer and click the pen tool (set its properties to a no fill stroke 

line). 

12. Hold the Shift key down and click on the SmartMark™ at its bottom left corner, then on its 

bottom right corner, and finally on its top right corner. This will create a line for the 

registration cut and establish the “cut zone”. 

13. Toggle the die line layer to hide its visibility. 

14. Save the work as a multi-layer format. 

15. Print the labels with the registration mark onto your label stock, using a rewinder for the 

printed labels. 

 

It is not necessary to add registration marks for each “label” within a frame. Only one set of marks per frame 

are required. 

When the labels are webbed through the DLF-1100, the Origin mark should be at the leading edge of 

each frame near the back edge of the label roll. 

 

  

Direction of label travel through the DLF-1100 

Operator side 
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Multiple Registration Marks 
Multiple registration marks are generally created when the print itself is skewed or if the labels 

require intricate cuts. It may be advantageous to use a skew or scale registration mark when multiple 

labels are created and cut in a single frame. 

“Skew” and “Scale” marks are created in the same manner as the original registration mark but 

located as follows: 

1. The Skew registration mark should be located flush to the lowest die line ¼” left of the 

left-most die line. 

2. The bottom of the Scale registration mark should be flush with the top die line and ¼” 

to the right of the right-most die line. 

 

Be sure to set the Find Origin property in DirectCut based on which registration marks you are using 

(see page 23). 
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Webbing the DLF-1100 Digital Label Finisher 

Webbing Guide for DLF-1100 Digital Label Finisher 
 

 

 

 

 

 

= PRINTED MEDIA 

= LAMINATE 

= LAMINATE WASTE 

= WASTE/MATRIX 

 

 

 

 

 

 

 

 

To web the DLF-1100 Digital Label Finisher follow the steps below: 

1. Power on finisher. 

2. The 4 web roller guides (black thin donuts) on accumulator 

arms are factory set for 8.5 in material. If using a different 

sized material, loosen the donuts. 

3. Load label roll on to mandrel & center to the black rubber 

lamination roller (Smart-Mark towards the gear side). 

4. Feed label roll through laminate roller, through nip roller 

(make sure black lever is up at 12 o’clock) & back onto itself 

to check if square. See image to the right for an example. 

5. Once the roll is confirmed square, lock down the nip roller 

by rotating the black lever to the 6 o’clock position. This 

will hold the material in place. 
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Webbing the Laminate 
1. Load and center laminate onto upper left mandrel (sticky side up). 

2. Pull down laminate over label roll & square with label roll 

3. Fold over 1”+ of laminate onto itself as a leader, this way it will not stick to the material 

when you pass it through the lamination roller. 

4. Feed laminate through (under) laminate roller, verify the laminate is square to printed roll, 

rotate black lever counter clockwise to lower laminate roller. 

5. If using laminate with a liner, wrap the waste liner clockwise around the laminate and onto 

the waste take-up spool.  

6. Feed 4-5ft of material to web the rest of the system, while doing this you can also straighten/ 

smooth out any wrinkles in the laminate. Do this by: 

a. Press the Advance Supply button to start feeding material. 

b. While material is feeding, open and close laminate roller handle a couple of times to 

help square laminate to label roll and allow laminate to find it’s true web path. (adjust 

laminate roll position on mandrel if necessary) 

c. Hit Advance Supply button to stop input nip roller from feeding. 

7. Feed media under accumulator. 

8. Feed media back up and over cutting bed. 

9. Feed media under output accumulator and up through output nip. Confirm media is straight 

and lock down the output nip black lever. 

10. Verify roll is square with all loops so far. 

Webbing test 
This quick test will help ensure that the system is webbed as straight as possible. 

1. Raise pinch wheels on cutting platform. 

2. Make sure web roller guides (black thin donuts) are loose. If preset from previous run with 

same roll size, try webbing test first then adjust as necessary. 

3. Press the Load button on the front panel of the DLF-1100 Digital Label Finisher.  The input 

accumulator will lower to bottom and the output accumulator will rise to the top. Once 

accumulators stop moving press the Load button a second time to disarm the system. The 

red LED next to Load on the front panel of the cutter is off. 

 

(continued)  
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4. With the input (left) accumulator down and the output (right) accumulator up – move the 

accumulators up and down to check tracking. Hold each accumulator as shown in A, then 

move accumulators to opposite positions as shown in C.  Watch the paper at B as the output 

accumulator goes to bottom if the web moves in either direction 

5. If material runs straight on the ruler at B, with little to no operator to gear side movement 

then the material is webbed straight. 

6. If material moved to operator side when the right accumulator is lowered, move the material 

towards the operator side. To adjust, hold end of material before releasing output nip black 

lock lever so the accumulator will not pull material backwards and drop to bottom. Adjust 

material to operator side the desired amount to square. Repeat webbing test. 

A. B.      C. 

     

7. If material moved to gear side when the right accumulator is lowered, move material 

towards gear side. To adjust, hold end of material before releasing output nip black lock lever 

so the accumulator will not pull material backwards and drop to bottom. Adjust material to 

gear side the desired amount to square. Repeat webbing test. 

8. When straight (within 1/32”), adjust pinch wheels so that each wheel is approximately 0.5” 

from edge of material, then lock down the pinch wheels by lowering the pinch handle and 

tighten the web roller guides (black thin donuts). 

Test Cut 
Once the DLF-1100 Digital Label Finisher is webbed, a test cut may be performed to ensure the 

proper cut depth. The labels should peel out with ease without cutting into the liner. 

1. Hit the Load button on the DLF-1100 control panel (arms system). 

2. Press and hold the down arrow button to bring out cutter carriage above the material. 

3. Press the “TC” button on the front control panel to perform a test cut. 

4. Weed the test cut and check for a clean cut without scoring of the liner. 

5. If the cut is not deep enough increase the force and/or expose more blade length. If liner is 

cut then reduce force and/or expose less blade length. It is best to have the least amount of 

blade exposed and apply more force. 

6. Once desired cutting force is achieved line up the red LED on the cutting head with the upper 

right hand corner (flush with top) of the SmartMark. 
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Creating the “Cut” File for the Finisher 
In “Registration Mark Placement and File Creation”, a file was created with a registration mark to 

define the cutting path in the label graphics file. The next step is to export or “send” this file to the 

DLF-1100 using the DirectCut program. This program tells the finisher where the cutting path is on 

the media. 

For information about installing the DirectCut add-ins for Adobe Illustrator or CorelDraw, please see 

the DirectCut Help file. 

Creating Plot File with Adobe Illustrator 
1. Open your label-cutting file (as created above) using Adobe Illustrator. 

2. Open the layer window. If the layer window is not visible, you can make it visible by clicking 

on Window -> Layers. 

3. Select the die-lines layer on the layer menu. 

4. Click on File -> DirectCut to open the DirectCut program for Illustrator. 

5. Verify the drop down box between the Cut and Properties button is set to the finisher, either 

via USB or Ethernet.   

Before clicking the Cut button, verify the properties in the DirectCut Properties section of the manual 

(see next page). 

Creating Plot File with CorelDraw 
1. Open the label-cutting file (as created above) using CorelDraw. 

2. Open the object manager. If the object manager is not visible, you can make it visible by 

clicking on Window -> Dockers -> Object Manger. 

3. Select the die lines layer on the object manager tab. 

4. If the DirectCut tool  does not appear near the view button, select Tools -> Options -> 

WorkSpace. Then check Afinia Label. 

5. Click on the DirectCut button to open the DirectCut for CorelDraw preview window. 

6. Verify the drop down box between the Cut and Properties button is set to the finisher, either 

via USB or Ethernet.  

Before clicking the Cut button, verify the properties in the DirectCut Properties section of the manual 

(see next page). 
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Important DirectCut Properties 
The four most important settings required to align the cutter to your artwork are: 

Find Origin 
Use this option to interface with the SmartMark sensor for 

cutting printed labels. 

• None sends no find origin command.  Job origin is 

placed at the carriage after a joystick move. 

• Origin sends the find origin command and does an 

alignment with the visual sensor at the origin only. 

• Origin, Skew sends the find origin command with 

0 for the x parameter and the largest y coordinate 

in the job.  This does alignment at the origin and 

rotation using the skew point. 

• Origin, Skew, Scale sends the find origin command 

with the largest x coordinate in the job and largest 

y coordinate in the job.  This does alignment at the 

origin, rotation at the skew point and scaling at the 

scale point. 

• Origin, Scale sends the find origin command with the largest x coordinate in the job and 

zero for the y coordinate in the job.  This does alignment at the origin, rotation at the scale 

point and x-axis only scaling at the scale point.  It assumes that the scaling in the y-axis is 

correct. 

• Edge Offset is used only when cutting blank labels on unprinted material. By selecting EDGE 

in the driver's printing preferences menu, the SmartMark sensor will detect the edge of the 

media instead of a registration mark, then offset into the media by that amount and cut 

your blank labels.   Edge sends the find edge command with the edge offset specified.  For 

use with unprinted stock on DFS only to align the cut with the edge of the media. 

Note:  Weed Border must be set to Off to use Find Origin with SmartMark. 

Rotate Image 
In the preview window, select DFS origin. This moves the origin to the upper right on the screen. This 

matches the view you see when you look at the printed roll from the front of the DLF-1100. Use the 

rotate selection in the properties until the origin registration cut or L cut is in the upper right corner 

of the preview screen. Select rotation from (none, 90°, 180°, or 270°). 

Sort Method 
Default: Distance.  Distance sort minimizes pen up movement.  Increasing X sorts loops by increasing 

max x coordinate value in loop.  Distance sort takes more computer time (n squared) than Increasing 

X sort (n log n).   

• Increasing X sort minimizes x movement during the plot.  You can use this option to 

improve repeatability.   

• Distance sort minimizes the time it takes to cut the job.  This sort finds the next closest 
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object to cut.  Since pen up time is minimized this is the fastest the job will cut.   

• Closest is similar to Distance except that it looks with in a closed object for closest point 

within the object.  This method takes the most computer time in that it does (n squared 

comparisons where n is the number of points rather than number of objects).  On slow 

computers and large drawings this can take several minutes or longer. 

• Distance No Color allows changing pen speed and force within a single object.  It is identical 

to distance except pen color is ignored.  Also if this method is used the color violet is not 

output to cutter. 

• Tiled is not used on the Afinia DLF-1100. 

Space between jobs 
The space between jobs tells the system how far to advance the cutting head in order to find the 

next frames Origin SmartMark. It is the distance between the last cut of the previous frame to the 

leading edge of the target of the next frame. 

You can also set the Space between jobs to Auto.  After the first Cut is sent, the DLF-1100 will locate 

the next SmartMark and automatically calculate the space between jobs. 

 

 

Example: Space 

Between jobs with 

Origin SmartMark 

only. 

 

 

 

 

 

Example: Space 

Between jobs with 

Origin, Skew, Scale 

SmartMarks. 

 

 

 

 

This setting combines with the Space between Jobs setting in the Remote Panel application. 
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Other DirectCut Properties 
The remaining DirectCut Properties are listed below.  Some of these properties 

are hidden by default as they either do not apply to operating the DLF-1100 or 

are rarely used; these properties are headed in light blue.  The hidden 

properties can be made visible by checking unchecked properties in the 

DirectCut Options application. 

To open the DirectCut Options, click the Start Menu -> Afinia Label -> Cutter 

Driver -> DirectCut Options link. 

Paper Size 
Selecting the paper size is not necessary for operating the DLF-1100.   

Copy Count 
The setting allows specifying more than one copy of the output to be cut.  Only one copy is sent to 

the cutter unless a different number is specified.  If you have copy count set to 6 and Copies/Row set 

to 2 then you will get 6 copies of the image in a 2 across and 3 rows of images. 

Print Quality / Resolution 
Normally you do not need higher resolution than 1016 dpi. 

Scaling 
This setting changes the final size of the objects cut on the cutter.   

Note: Scaling that would make the cut path wider than 8.5” is not supported.Copies / Row  

This allows multiple copies of the image to appear side by side in the y-axis.  The space between jobs 

controls the distance between the jobs.  This allows for step and repeat of a single cut pattern to be 

applied multiple times in a single frame.  The total copy count is divided by the pages per sheet so 

copy count is the number of copies of the pattern to cut. 

Edge offset 
This option is used with the Find Origin Edge method to specify the offset between the edge of the 

media and the cut line. 

This setting combines with any Y Offset entered into the Remote Panel application. 

Combine Polygons 
If your CAD system does not combine all the points of an object together into a single object (for 

example, PowerCAD, MonumentCAD, and AutoCAD do not) you should set this option to Yes to 

improve cut quality.  The driver will analyze the polygons in the print job and combine the polygons 

together.  Three options are available: copy 1st to end of 2
nd

, copy 1
st

 to end of 2
nd

 reversing 

direction, and reverse direction of 1
st

 and copy 2
nd

.   

For large jobs this process can take several minutes.  
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Same Point Distance 

This option works with Combine Polygons set to Yes.  The variable controls how far away the 

combine polygon algorithm looks for an end point to decide if the point is the same point.  A 

value of 0 will only consider points that are coincident to be the same.  A value of 25 is about 

1/8 of an inch (3 mm). 

Loop Control 
Default is All Counter Clockwise, which traverses all loops counterclockwise.  All Clockwise traverses 

all loops clockwise.  Some cut quality improvement can be realized on some media by making all 

loops the same direction. 

Mirror  
This option allows cutting a mirror image of the job.  For example if you want to put letters on the 

inside of a window you can mirror the image and it will appear correct when viewed from the 

outside of the building. 

Multiple Pen Output 
This property is not supported for use with the DLF-1100. 

Weed Border 
This option adds a weeding border cut space between jobs outside of the maximum dimensions of 

the image being cut.  This increases the size of the image by 2 times the Weed border distance.  

Note: This option is not compatible with Find Origin.  Weed border should be set off if Find Origin is 

on. 

• Weed border distance is the amount of increased image size the weed border expands the 

image.  Range 0 to 1 inch (0 to 2.54 (cm)).  Units of measure can be selected from control 

panel, regional and language options, customize, measurement system. 

Minimum Vector Length 
Some cad programs output too many vectors or an inconsistent number of vectors depending on the 

object.  This feature allows outputting more vectors than are needed and having the driver space the 

points along an arc based on the distance and the angle between vectors.  Range 0.004 to 0.1 inches 

(0.01 to 0.25 (cm)).  Units of measure can be selected from control panel, regional and language 

options, customize, measurement system. 
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End Point 
This option allows selecting either “End of Job” or “Origin”.  Selecting “End of Job” moves the knife 

to the end of cut.  Selecting Origin leaves the cutting head at the beginning of the job. 

Unroll Media Before Plot Count 
Selecting 0 starts job without moving media.  Selecting 1 causes the cutter to move the media 

forward to the end of the job so that the cutter does not pull media off the roll in the middle of a job.  

See also Speed to pull media off roll. Selecting > 1 causes the cutter to move the media forward so 

that the cutter does not pull media off the roll in the middle of the job.  In addition it moves the 

media through the grit roller the selected number of times before starting the job.  This function is 

necessary when using a template cutter to achieve optimal registration.  

Recommendations:  

Set to 0 for DFS, 0 for QuickSand, 1 for vinyl/rubber cutters and 2 or greater for template makers.  

Default is 0 after installation.  A count of 3 will move the media forward and back 3 times before 

plotting. 

Rubber Mode 
This property is not used with the DLF-1100. 

Send Force to tool 
Setting this to Yes allows you specify a percentage to override the default cutting force of 20% on 

the cutter.   

The cutting force is shown on the cutter display, which can be changed on the cutter during 

operation or by changing the force in the Remote Panel application. 

Force Applied for each tool 

As the DLF-1100 does not have multiple knives, only the first knife force can be set. 

Send Speed to tool 
Setting this to Yes allows you specify a percentage to override the default cutting speed of 100% on 

the cutter.   

The cutting speed is shown on the cutter display, which can be changed on the cutter during 

operation or by changing the speed in the Remote Panel application. 

Speed Applied for each tool 

Only the first knife is used with the DLF-1100. 

Speed to pull media off roll 

If the send speed to tool is turned on, the specified velocity for unrolling media is used when 

feeding media through the input accumulator.  

Speed to travel when tool is up 

This is the speed the motors will travel when the tool is not in contact with the media. 
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Up speed = Down speed 

When set to Yes, the cutter ignores the Speed to travel when tool is up parameter.  The Down 

speed will be used for the Up speed. 

Output Polyline Encoded 
By default the driver outputs data in non-Polyline encoded (uncompressed) format.   

Debug 
Off no debug is output 

On debug is sent to c:\temp\cutter.wri and c:\temp\cutui.wri 

On Page – Debug is turn on during DrvSendPage 

Setting Debug to On will increase the processing time dramatically 

 

DirectCut Options Application 
Open the DirectCut Options application to change 

which of the DirectCut Properties are visible. 

Any property with a check mark will be visible from 

within DirectCut. 

Some of the properties available do not apply to the 

DLF-1100.  

After making any changes, simply close the Options 

application.   
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Sending Cut Files  
The section below uses Adobe Illustrator as the example software. 

1. Launch Adobe Illustrator 

2. Open label in AI (File > Open) 

3. Select die-line in layers (will highlight blue) 

4. Cut or die line is in layers dialogue box (if layers box not open, go to top menu bar & select 

Window > layers (confirm the ‘eye’ is in the left box to show cut line) 

5. Go to top menu bar and select - File > Afinia DirectCut 

6. Rotate original image on screen to match actual roll orientation in finisher  

7. Click properties in DirectCut dialogue box; change “Rotation” if necessary 

8. Load cores onto waste matrix & take-up mandrels 

9. Web material under silver weed roller (narrow roller that has collapsible side so it can be 

removed), separate the top layer of material from the liner. Web the waste over the weed 

roller and attach it to the waste take up (matrix) mandrel. Now web the liner over the silver 

stationary roller and adhere to the lower core. 

10. Use the Left or Right arrows on the joystick controls on the 

DLF-1100 to move the label so the next SmartMark is just to 

the left of the laser sight.   

The joystick changes the relative positions of the label and the 

cutter as if the label stock is in a fixed position.  That means the 

Left button will move the labels to the right (as if the cutter moved 

to the left) and the Right button will move the labels to the left (as 

if the cutter moved to the right). 

Note:  If the accumulators do not adjust during this motion, you 

may end up with too little material on one side and too much on 

the other.  Use the Advance Supply and Advance Take-up buttons 

if necessary. 

11. Use the Up or Down arrows on the joystick control to move the cutter knife so the laser sight 

is at the top right corner of the SmartMark.  The Up arrow moves the cutter towards the 

back while the Down button moves the cutter towards the front. 

12. Turn on matrix switch (silver switch on side of control panel on finisher) 

13. Turn on take-up switch (tension knob controls speed/tension of take up mandrel) 

14. Press the Cut button in DirectCut window. The finisher will cut one frame. Inspect to see that 

the cut is acceptable. If not, adjust the knife force using the Force buttons on the controls. 

15. If Space between jobs was set correctly, press copy button, use arrows to set # of labels, 

then press select. 
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Remote Panel Application and Adjustments 
Once you’ve got the cut file to the DLF-1100, you can use the Remote Panel to make any 

necessary adjustments to the cut position, space between jobs, and a number of other 

settings without having to resend the cut job. 

To launch the Remote Panel, click the DLF-1100 Remote Panel icon on your desktop. 

There are a number of settings that can be changed from the Remote Panel.   

To change the cutting settings, click within the red circle around the display to access the Cutter 

Menu.  Once there, click the SmartMark button to open the Smart Mark Sensor Menu. 
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Registration X- and Y-Axes 
The two buttons for the X and Y axis 

registration display the current offsets.  

To change the offsets, click the 

appropriate axis button.  Enter the new 

offset using the number pad.   

Click the Save button to apply the 

change. 

For the X-Axis, increasing the number 

will move the cut to the right and 

decreasing the number will move the 

cut to the left. 

For the Y-Axis, increasing the number 

will move the cut to the back and 

decreasing the number will move the 

cut towards the front. 

The next cut will use the new offset values. 

Note:  The registration offset settings will be combined with settings such as Edge Offset in the 

DirectCut Properties. 

Space || (between) Jobs 
The Space Between Jobs setting is also a key setting for aligning the cut to your labels as it tells the 

cutter how far to travel before looking for the next SmartMark. 

The simplest way to use this setting is to set it to 0 and set the DirectCut Space Between Jobs 

property to auto (before sending the cut).  In this configuration, the cutter finds the distance 

between the end of the first cut and the next mark and uses that value automatically. 

If you know the exact distance from the cut closest to the next mark and that mark, you can enter 

that number here. 

Note:  This setting and the DirectCut Space Between Jobs property value will be added together 

when the cut is positioned.  It is recommended that if you are specifying a Space Between 

Jobs distance, you should enter the calculated distance in DirectCut and use the Remote 

Panel setting for minor adjustments if needed. 

 

  



DLF-1100 Page 32 

 

Using Accessories 

Weed Bar 
The Weed Bar is used when cutting medium to larger sized shapes. The bar is spring-loaded and can 

be installed or removed without using any tools. 

To remove: Push the bar toward the gear side of the machine and lift it out from the operator end to 

release it. 

To install: 

1. Take the O-rings from the accessory kit and install them onto the weed bar. 

2. Insert the bar (spring end first) into its mounting hole on the gear side of the machine. 

3. Push the bar toward the gear side of the machine while aligning it with the mounting hole on 

the operator side. 

4. Let go of the bar so that it springs into place. 

5. Slide O-rings into place so that they will roll over the labels or cut lines. 

 

 

 

Managing Tension 
There are five mandrels on the DLF-1100 that may require tension adjustments during operation as 

the diameter of the material on the mandrel changes. 

The Supply and the Laminate mandrel tension adjustments will be needed less frequently, and 

require the ¼” allen wrench included in the accessory box. 

The Laminate Waste, Waste/Matrix, and Takeup mandrels can each be adjusted independently and 

need to be monitored more closely than the Supply and Laminate tension.  Each of these three also 

has an independent On/Off switch for the mandrel motors. 

Supply Mandrel 
The supply mandrel tension is adjusted by using the ¼” allen wrench included in the accessory box in 

the lower port on the left side of the DLF, labelled Supply Tension.  Turn the wrench clockwise to 

increase tension, counter-clockwise to decrease tension.   
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The supply tension should be changed if the supply is unwinding unevenly or the supply continues to 

unwind after the feed roller stops (increase tension), or if the label stock is too tight (decrease 

tension). 

Laminate Mandrel 
The laminate mandrel tension is adjusted by using the ¼” allen wrench included in the accessory box 

in the upper port on the left side of the DLF, labelled Lam Tension.  Turn the wrench clockwise to 

increase tension, counter-clockwise to decrease tension. 

The laminate tension should be increased if the laminate: 

• is loose between the roll and the laminate roller 

• is unwinding unevenly  

• continues to unwind after the feed roller stops  

Note that the Laminate Waste mandrel tension can have a small effect on the laminate tension; if 

you change one, check the other. 

Laminate Waste Mandrel  
The Laminate Waste tension controls are to the left of the Laminate Waste mandrel.  If you are using 

lined laminate, you will need to be sure the motor is turned On.  The mandrel will only turn while the 

feed roller is running. 

The laminate should be peeling off the roll near the point closest to the laminate roller.  If it isn’t, the 

Laminate Waste tension will need to be adjusted.   

If the laminate is counter-clockwise and moving farther in that direction during feed, turn the 

tension knob counter-clockwise.  If it is clockwise of the laminate roller and moving farther in that 

direction during feed, turn the tension knob clockwise. 

Waste/Matrix Mandrel 
The Waste/Matrix mandrel motor will always be running when turned On to maintain tension in the 

waste material.  The controls are the top switch and knob on the right side of the control console. 

Tension should be set so the waste material is tight on the weed bar without 

tearing the matrix when at rest and is keeping up with the output when 

feeding.  There is usually a wide operating range, but as the waste roll 

increases in diameter you may need to reduce tension. 

Takeup Mandrel 
The Takeup mandrel motor will always be running when turned On to 

maintain tension in the output roll.  The controls are the bottom switch and 

knob on the right side of the control console. 

Tension should be set so the winding is keeping up with the output when 

feeding and the rolling is tight.  There is usually a wide operating range, but 

as the takeup roll increases in diameter you may need to reduce tension. 
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Maintenance & Consumables 
Operating maintenance performed on this machine will require the tools that are shipped in the 

Accessory Kit. Replacement parts and tools may be ordered using our online store at 

www.afinialabel.com. 

Fuses 
There are two (2) spare fuses provided with the Finisher. If you have 

110v AC use one 5-amp fuse. If you have 220v AC use two 2.5-amp 

fuses (remove the shorting clip to use two fuses). 

Replacing a Fuse 

1. Disconnect the AC power cord from the fuse block on the 

power input end panel. 

2. Open the fuse block cover with a small flat screwdriver 

and pull out the fuse block. 

3. Remove the spent fuse and replace with a new one. 

4. Orient the fuse block so that the desired voltage appears 

in the fuse block cover. 

5. Close the fuse block cover and verify that the desired voltage is showing. 
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Changing the Knife Blade 
The knife blade should be replaced when the force has been increased by more than 20 percent or 

the cut quality has degraded. The first sign of blade degradation usually occurs in the corners of the 

cut and may lead to poor weeding. 

1. Remove the used blade 

a. Loosen the brass thumbscrew on the carriage tooll block and remove the knife holder 

assembly. 

b. Unscrew the black tip of the Knife Holder assembly. 

c. Remove the blade from the knife holder assembly. 

d. Discard the blade safely. 

2. Insert a new blade 

a. Take out a new blade from its plastic case and remove the 

protective latex cap. Cap color indicates blade angle (Red = 45º 

blade, Green = 60º blade, Blue = 30º Blade). 

b. Carefully insert the new blade into the holder assembly. 

c. Turn the end cap to obtain desired blade depth. 

3. Replace the Knife Holder Assembly in the tool block on the cutter carriage. 

a. Ensure that the shoulder of the assembly is seated flush with the top of the tool block. 

b. Tighten the thumbscrew on the tool block to keep the knife holder in place. 
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Changing the Cut Strip 
The Cut Strip should be replaced when the cut quality deteriorates. 

1. Move the knife carriage to the gear side of the cutter. 

2. Clean any debris from the cut strip groove before removing the existing strip. 

3. Use the Cut Strip Removal Tool, found in the white accessory kit, to remove the worn strip. 

a. Place the hooked end of the tool under one end of the Cut Strip 

b. Pull up gently until there is enough material to pull up by hand. Cut Strips are held in 

place with light easy to remove adhesive. 

4. Clean any debris from the groove and inspect before installing 

the new Cut Strip. 

5. Peel the backing off the new cut strip and place in groove. 

6. Press down firmly to ensure proper seating. 

NOTE:  It is important to install the Cut Strip fully and evenly, 

otherwise material “cut through” may occur in some sections 

across the cutter. 

7. Two different cut strips are available from the 

http://afinialabel.com online store. “Normal life” and 

“Advanced life” cut strips. 
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Cleaning the DLF-1100 Digital Finisher 
The regularity with which the cutter needs to be cleaned is dependent on the usage, as well as the 

climate and contaminants in the cutter’s environment. It is recommended that the following 

cleaning steps be done at least as often as indicated for each procedure. 

ALWAYS disconnect the power source while cleaning any part of the machine. 

Keep power source disconnected until the cleaning process is completed. 

Items needed for cleaning: 

● Small bristle brush (toothbrush) 

● Soft cloths 

● Rubber roller cleaner 

● Mild solution of soap and water. 

Biweekly Cleaning 

Grit Rollers 

The grit roller, pinch wheels, and the nips move the media through the finisher. Keeping the 

grit rollers clean allows the cutter to hold the media properly. Clean the grit rollers with a stiff 

bristled brush (e.g. toothbrush) to remove any media particles built up during cutting. 

1. Disconnect power from machine 

2. Disengage rubber rollers and pinch wheels from the grit rollers (handles in up position) 

3. Do not use a wire bristle brush. A wire brush will damage the Grit Roller. 

4. Brush the surface of the grit wheel while turning the grit roller by hand so the entire 

surface of the grit wheel is cleaned. 

Pinch Wheels 

Wipe media-related dust from the set of polyurethane pinch wheels using a soft cloth. To clean 

adhesive off the pinch wheels, simply use a soft cloth and rubber roller cleaner. 

(continued on next page) 
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Rubber Rollers 

Clean using rubber roller cleaner and a soft cloth.  Adhesive build-up may be removed using the 

roller cleaner and gently scraping the surface. 

NOTE: Use a rubber roller cleaner such as the type sold in office supply stores. Avoid using 

Isopropyl or denatured alcohol on rubber parts as alcohol will dry and harden the surfaces. 

Metal Rollers and Guides 

Inspect for dust or adhesive build up. Remove dust using a soft cloth. Adhesive build-up may be 

removed using a small amount of Isopropyl alcohol and gentle scraping with a fingernail. 

Monthly Cleaning 
Clean the outer surface of the machine. If necessary, a mild cleaning solution (such as mild 

soap and water) on a damp cloth can be used to gently wipe painted surfaces clean. 

Do not use abrasive cleaners. Abrasive cleaners will cause the paint to blister. Use 

a solution of mild soap and water. 

Annual Cleaning 
Observe static discharge safety procedures that may damage sensitive electronic components. 

Wear a grounding strap connected to earth ground. Wear safety glasses to protect eyes. 

ALWAYS disconnect the power source while cleaning any part of the machine. 

Keep power source disconnected until the cleaning process is completed. 

1. Remove rear cover 

2. Use compressed air to remove dust and debris. 

3. Inspect the internal circuit board assemblies and clean accumulated dust as necessary. 

4. Make certain that the boards and any connectors are well seated. 

5. Replace cover to original location. 
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Pinch Wheel Maintenance 
Pinch wheels are critical to the DLF-1100 material handling performance. They should be 

inspected for wear regularly and cleaned as needed. This will prolong the performance & life of 

the pinch wheels, however, in normal use the pinch wheels will need to be replaced in time. 

The pinch wheels may need replacing when media does not track properly after guide 

alignment has been verified. For best tracking results, pinch wheels should be replaced as a 

SET. 

Visually Inspect Rubber Wheel 

The rubber wheel should not have any cracks or flat spots. It should be securely fastened to the 

aluminum hub of the wheel. The transition from the flat surface of the wheel to the “sidewall” 

edges of the wheel should be sharp and not rounded. 

 

Inspect Wheel Bearings 

1. Raise the pinch wheel handle to lift the pinch wheels. 

2. Spin each wheel one at a time. Listen to the sound the bearing makes. A dry sound 

indicates the wheels need replacing. 

Pinch wheels are available from the online store at www.afinialabel.com. 
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